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GETTING STARTED GUIDE

NI Digital Waveform 
Generator/Analyzer
For NI PXI-6551/6552 Modules

This document explains how to install, configure, test and set up a National 
Instruments digital waveform generator/analyzer. This document applies 
specifically to the NI PXI-6551/6552 (NI 655X) modules. For more 
information on the NI 655X, such as features and programming, refer to the 
NI Digital Waveform Generator/Analyzer Help at Start»Programs»
National Instruments»NI-HSDIO» Documentation»NI Digital 
Waveform Generator/Analyzer Help.

Refer to the specifications document that ships with your module for detailed 
specifications.

For free downloads of the most current versions of product documentation 
and example programs, visit ni.com/instruments.
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Conventions
The following conventions are used in this guide: 

<> Angle brackets that contain numbers separated by 
an ellipsis represent a range of values associated 
with a bit or signal name—for example, DIO<3..0>.

» The » symbol leads you through nested menu items 
and dialog box options to a final action. The 
sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup 
item, and select Options from the last dialog box.

This icon denotes a tip, which alerts you to advisory 
information.

This icon denotes a note, which alerts you to 
important information.

This icon denotes a caution, which advises you of 
precautions to take to avoid injury, data loss, or a 
system crash. When this symbol is marked on the 
product, refer to Safety Information section for 
precautions to take.

bold Bold text denotes items that you must select or click 
on in the software, such as menu items and dialog 
box options. Bold text also denotes parameter 
names.

CompactPCI CompactPCI refers to the core specification defined 
by the PCI Industrial Computer Manufacturers 
Group (PICMG).

italic Italic text denotes variables, emphasis, or a cross 
reference. This font also denotes text that is a 
placeholder for a word or value that you must 
supply.
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monospace Text in this font denotes text or characters that you 
should enter from the keyboard, sections of code, 
programming examples, and syntax examples. This 
font is also used for the proper names of disk drives, 
paths, directories, programs, subprograms, 
subroutines, device names, functions, operations, 
variables, filenames and extensions, and code 
excerpts.

monospace italic Italic text in this font denotes text that is a 
placeholder for a word or value that you must 
supply.

PXI PCI eXtensions for Instrumentation (PXI) is a 
rugged, open system for modular instrumentation 
based on CompactPCI, with special mechanical, 
electrical, and software features. These features, 
such as the PXI trigger bus, are described in the PXI 
Specification Revision 2.0, which is available from 
ni.com/manuals.

Step 1. Unpack the Hardware
The NI 655X ships in an antistatic package to prevent electrostatic discharge 
(ESD). ESD can damage several components on the module.

Caution Never touch the exposed pins of connectors.

To avoid ESD damage in handling the module, take the following 
precautions:

• Ground yourself with a grounding strap or by holding a grounded object.

• Touch the antistatic package to a metal part of your computer chassis 
before removing the module from the package.

Remove the module from the package and inspect it for loose components or 
any other signs of damage. Notify NI if the module appears damaged in any 
way. Do not install a damaged module in your computer or chassis.

Store the module in the antistatic package when the module is not in use.

Step 2. Verify the Components
Make sure you have the following items:

❑ NI 655X digital waveform generator/analyzer

❑ NI-HSDIO (High-Speed Digital I/O) driver software CD
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❑ The documentation included with the digital waveform 
generator/analyzer and driver software. Refer to the Documentation 
section for a listing of the documentation you may have.

❑ PXI/CompactPCI chassis and controller

❑ Phillips screwdriver 

❑ One of the following application development environment (ADE) 
software packages and documentation:

– NI LabVIEW 7.0 or later

– NI LabWindows™/CVI™ 6.0 or later

– Microsoft Visual C++ 5.0 or later

Optional Equipment and Software
NI offers a variety of accessory products to use with the NI digital waveform 
generator/analyzer, including the following items:

• NI CB-2162—Connector block accessory with a prototyping area for 
creating custom circuitry.

• SHC68-C68-D2—Shielded cable recommended for connections with 
NI high-speed digital instruments.

The NI Digital Waveform Editor (DWE) is a separate software application 
that you can purchase from NI to use with your module to easily create and 
edit digital patterns.

For more specific product information, refer to ni.com/catalog.

Documentation
The NI digital waveform generator/analyzer ships with several documents 
designed to familiarize you with different aspects of the module. The 
documentation set includes the following pieces:

• NI Digital Waveform Generator/Analyzer Getting Started Guide—Read 
this printed document to set up the digital waveform generator/analyzer 
and configure it to complete your first acquisition or generation.

• NI Digital Waveform Generator/Analyzer Help—This online document 
provides more in-depth information about the hardware capabilities of 
the module, theory of operation discussion, programming flow, and 
software reference.

• NI digital waveform generator/analyzer specifications—This printed 
document provides specifications for your module.
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Step 3. Install the Software
This section describes the software installation process for the NI digital 
waveform generator/analyzer.

Choose and Install Your ADE
You can create applications for your digital waveform generator/analyzer 
using LabVIEW 7.0 or later, LabWindows/CVI 6.0 or later, or Microsoft 
Visual C++ 5.0 or later.

Note LabVIEW features interactive graphics, a state-of-the-art 
interface, and a powerful graphical programming language. 
LabWindows/CVI is a complete ANSI C ADE that features an 
interactive user interface, code generation tools, and the 
LabWindows/CVI Data Acquisition and Easy I/O libraries. Using 
LabVIEW or LabWindows/CVI can greatly reduce your 
application development time.

If you have not already installed the ADE, follow the instructions in the 
product documentation to install your ADE now.

Install NI-HSDIO
The NI digital waveform generator/analyzer ships with the NI-HSDIO driver 
software. NI-HSDIO features a set of operations and attributes that allow you 
to programmatically configure and control the digital waveform 
generator/analyzer. Refer to the Programming section of the NI Digital 
Waveform Generator/Analyzer Help for information on creating an 
application with NI-HSDIO.

To install NI-HSDIO, complete the following steps:

1. Insert the NI-HSDIO CD. The NI-HSDIO installer should open 
automatically. If not, select Start»Run, and enter x:\setup.exe, 
where x is the letter of the CD drive.

2. Follow the instructions in the installation prompts. For troubleshooting 
and operating system-specific instructions, refer to the Hardware 
Installation Wizard at ni.com/support/install.

Note If you are running Windows 2000/NT 4.0/XP, you must have 
administrator access to perform the installation.
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NI Script Editor
The NI Script Editor is included on the NI-HSDIO CD and is installed when 
you install the driver. The NI Script Editor provides an intuitive interface to 
aid you in developing linking and looping pattern generation operations. The 
NI Script Editor Help contains more information about the NI Script Editor.

(Optional) Install the NI Digital Waveform Editor
The DWE is included with the higher-memory versions of the NI 655X and 
also can be purchased separately. The DWE allows you to easily import data 
from popular third-party CAD programs, create your own waveforms, edit 
these waveforms, and view acquired waveforms.

If you are using the DWE, install it after you install NI-HSDIO.

Step 4. Install the Module
You can install the module in any available 5 V peripheral slot in a PXI or 
CompactPCI chassis. Follow the instructions in the procedure section that 
describes your chassis.

Procedure 1: Installing the Module in a PXI Chassis
To install the module, refer to Figure 1 and complete the following steps:

 

Figure 1.  PXI Installation

NI PXI-1042

PXI Device

Ejector Handle in
Down Position
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Caution To prevent damage to the module caused by ESD or 
contamination, handle the module using the edges or the metal 
bracket.

1. Power down the chassis before installing the module.

2. If the chassis has multiple fan speed settings, ensure that the fans are set 
to the highest setting.

3. Position the chassis so that inlet and outlet vents are not obstructed. For 
more information, refer to the chassis documentation.

Note Clean the fan filters on the chassis regularly to prevent 
airflow blockage.

4. If you need to use the provided EMI gasket to reduce high-frequency 
emissions, install it now. Refer to the Retrofitting Your PXI Module Note 
to Users for more information.

5. Ensure that the ejector handle is in the unlatched (downward) position, as 
shown in Figure 1.

6. Holding the module by the ejector handle, slide it into an empty slot, 
ensuring that the base card (on the left when looking at the front of the 
module) engages with the card guides in the chassis.

7. Slide the module completely into the chassis and latch by pulling up on 
the ejector handle.

8. Tighten the captive screws at the top and bottom of the module front 
panel.

9. Before operating the module, cover all empty slots using blank (EMC) 
filler panels.

NI PXI modules are sensitive instruments and should be handled carefully. 
Do not expose the module to temperatures or humidity beyond the rated 
maximums. Keep the module free of dust by cleaning with compressed air 
only. Do not clean the module with any solvents or liquids. For more 
information about module cooling, refer to the guidelines in the Maintain 
Forced-Air Cooling Read Me First included with your NI digital waveform 
generator/analyzer.

Procedure 2: Installing the Module in a CompactPCI 
Chassis
The procedure for installing the module in a CompactPCI chassis is the same 
as the procedure for installing the module in a PXI chassis, but the following 
additional considerations apply to using your PXI module with a 
CompactPCI chassis.
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• The CompactPCI specification permits vendors to develop sub-buses that 
coexist with the basic PCI interface on the CompactPCI bus. Compatible 
operation of NI PXI modules is not guaranteed between CompactPCI 
devices with different sub-buses nor between CompactPCI devices with 
sub-buses from different vendors and PXI. The standard implementation 
for CompactPCI does not include these sub-buses.

• The module works in any standard CompactPCI chassis adhering to the 
PICMG CompactPCI 2.0 R2.1 document. You can obtain this document 
from picmg.org.

• When you use the NI 655X as a plug-in device in a standard CompactPCI 
chassis, you cannot access PXI-specific functions. PXI-specific features 
are implemented on the J2 connector of the CompactPCI bus. The 
following table lists the J2 pins used by the NI 655X. This module is 
compatible with any CompactPCI chassis with a sub-bus that does not 
drive these lines. Even if the sub-bus is capable of driving these lines, the 
module is still compatible as long as those pins on the sub-bus are 
disabled by default and never enabled.

Table 1.  J2 Pins Used by the NI 655X

PXI Pin Description PXI J2 Pin Number

PXI_TRIG<0..7> PXI trigger lines <0..7>—the 
eight PXI bused trigger lines 
are highly flexible and can be 
used in a variety of ways; for 
example, triggers can 
synchronize several PXI 
peripheral modules

B16, A16, A17, A18, 
B18, C18, E16, E18

PXI_STAR PXI star trigger line—the 
star trigger bus implements a 
dedicated trigger line 
between the first peripheral 
slot (adjacent to the system 
controller slot) and the other 
peripheral slots

D17

PXI_CLK10 PXI Clock10 line—10 MHz 
PXI system clock distributed 
along the PXI backplane

E17
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Step 5. Configure the Module
1. Launch Measurement & Automation Explorer (MAX) to configure and 

test the digital waveform generator/analyzer. MAX should automatically 
detect the module you installed.

Note If MAX does not detect the module, you might need to 
refresh MAX by selecting File»Refresh from the MAX menu or 
pressing F5. If the device is still not recognized, refer to 
ni.com/support/install for troubleshooting information.

2. Expand Devices and Interfaces.

3. Expand NI-DAQmx Devices.

4. Check that your module appears under NI-DAQmx Devices.

5. You can perform a self-test on modules listed under NI-DAQmx Devices. 
The self-test ensures that the device is installed correctly and can 
communicate with NI-HSDIO. To perform a self-test, complete the 
following steps:

a. Right-click the module you want to test and select Self-Test (shown 
in Figure 2).

Figure 2.  Configuration Tree Shortcut Menu

b. When the self-test finishes, a message window appears to indicate if 
an error occurred. If an error occurred, refer to ni.com/support 
for troubleshooting information.

6. Record the device name assigned to the digital device. You will use this 
information when you program the module.
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Step 6. Use the Test Panel to Generate and 
Acquire Data
To verify your module configuration, use the device test panel in MAX to 
generate and acquire simple digital data using your module.

To generate digital data, complete the following steps:

1. Right-click your module under NI-DAQmx Devices, and select Test 
Panels from the shortcut menu shown in Figure 2.

2. Click the Generation tab. Select the Dynamic tab on the side of the pane.

3. Click Select All to select all of your channels. The digital pattern now 
appears in the graph.

4. Enter the frequency in the Clock Frequency control, located on the left 
side of the Test Panel.

5. Enter values for the generation and acquisition voltages in the controls 
below the Clock Frequency control. You can choose from standard logic 
families or enter High and Low values to create your own custom levels.

6. Choose a fill pattern. The following figure shows the pattern control and 
the first few signals in the window.

Tip When generating a Marching Ones or Marching Zeroes 
waveform, it is convenient to make the waveform size a multiple of 
the number of selected channels.

7. Click Play to generate the pattern shown in the graph on the selected 
channels. The default generation option is Continuous, but you can 
toggle this using the control below the graph.

The Play and Stop buttons are shown in the following figure.
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While the data is being generated continuously on all of the channels, as 
in the previous step, you also can acquire the data on all the channels. 
Since the data channels on the NI 655X are bidirectional, you can acquire 
the data being generated on the channel.

Note Refer to the specifications for your device for information on 
the setup and hold times and propagation delays associated with 
generation and acquisition operations. At some frequencies, 
generating and acquiring data on the same channels when no cable 
is attached to the DDC connector violates these timing parameters 
and results in incorrectly sampled data. For some information on 
proper signal acquisition, refer to the NI Digital Waveform 
Generator/Analyzer Help.

To acquire the pattern, complete the following steps:

1. Click the Acquisition tab.

2. Click Play. The module acquires the digital data you generated in the 
previous steps, and data is displayed on the graph.

3. Click Close when you are finished.

You have now verified your module and are ready to program your module.

Step 7. Connect Signals to the Front Panel
This section discusses what connections you can make to the module, and 
how to connect signals to the module.

Figure 3 shows the front panel of the NI 655X. The front panel contains four 
connectors—three SMB jacks (CLK IN, PFI 0, and CLK OUT) and one 
68-pin VHDCI connector (Digital Data & Control, or DDC). The connectors 
and their functions are described in Tables 1 and 2.
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Figure 3.  NI 655X Front Panel Connectors
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Table 1.  NI 655X SMB Connector

Connector
Signal 
Name

Signal 
Type Description

CLK IN Reference/
Clock Input

Control External reference clock used for the 
PLL or external sample clock used for 
pattern generation and/or acquisition.

PFI 0 Programmabl
e Function 
Interface 
(PFI) 0

Control Input terminal to the NI 655X for 
external triggers or output terminal 
from the NI 655X for events.

CLK OUT Reference/
Clock Output

Control Terminal for the exported PLL 
reference clock or the exported sample 
clock.

Table 2.  NI 655X DDC Connector Pins

Pins
Signal 
Name

Signal 
Type Signal Description

33 DDC CLK
OUT

Control Terminal for the exported sample 
clock.

67 STROBE Control External sample clock source which 
can be used for pattern acquisition.

13, 15, 17, 19, 
21, 23, 25, 27, 
29, 31, 47, 49, 
51, 53, 55, 57, 
59, 61, 63, 65

DIO <0..19> Data Bidirectional digital I/O data channels 
0 through 19.

26, 30, 64 PFI <1..3> Control Input terminals to the NI 655X for 
external triggers or output terminals 
from the NI 655X for events.

2, 4, 6, 10, 12, 
14, 16, 18, 20, 
22, 24, 28, 32, 
34, 36, 38, 40, 
42, 44, 46, 48, 
50, 54, 56, 58, 
62, 66

GND Ground Ground reference for signals.

1, 3, 5, 7, 8, 9, 
11, 35, 37, 39, 
41, 43, 45, 52, 
60

RESERVED N/A These terminals are reserved for future 
use. Do not connect to these pins.
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Connecting Cables and Accessories
To make connections to the NI 655X front panel SMB jacks, use a shielded 
50 Ω coaxial cable with an SMB plug end.

Use an NI SHC68-C68-D2 cable for connections to the NI 655X DDC 
connector. The NI SHC68-C68-D2 is designed for single-ended, high-speed 
digital signal transmission. The cable is shielded, with individual 
microcoaxial 50 Ω lines for each signal.

Note Do not use cables other than the NI SHC68-C68-D2 cable 
with your NI 655X.

NI recommends using an NI CB-2162 to access the signals on the 68-pin 
DDC connector and terminate DATA<0..19>. The NI CB-2162 also provides 
a platform for circuit prototyping and DUT testing. The NI CB-2162 is 
specifically designed for use with NI digital instruments. For more 
information about using the NI CB-2162, refer to the NI CB-2162 User 
Guide.

Figure 4 shows how to connect the NI digital waveform generator/analyzer 
and the NI CB-2162 using the NI SHC68-C68-D2 cable assembly.

Figure 4.  Connecting the NI CB-2162 Accessory
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Whether you use NI cables and accessories or design your own, you should 
properly terminate cables to avoid improper measurements due to signal 
reflections, overshoot, and undershoot. Refer to the NI Digital Waveform 
Generator/Analyzer Help for more information about signal termination.

Wiring for Common Measurements
Dynamic generation and dynamic acquisition are two categories of 
applications that you can create for the NI 655X. This section provides 
information on the general wiring considerations for each type of application. 
Both examples use the NI CB-2162 for signal termination.

Dynamic Generation
When performing dynamic generation, the NI 655X generates data through 
a matched impedance system that consists of a 50 Ω output impedance, 
50 Ω cable, and 50 Ω accessory. Depending on the loading of the peripheral 
device, you might need additional parallel termination resistance at the 
destination for optimal signal quality. Refer to the NI Digital Waveform 
Generator/Analyzer Help for more information about signal termination.

Figure 5.  Dynamic Generation Functional Diagram

Dynamic Acquisition
When performing dynamic acquisition, the source generating the signals 
needs a matched source impedance as close to 50 Ω as possible. This 
matching minimizes signal reflections and maintains optimal signal quality. 
Use NI-HSDIO to set the input impedance of the NI 655X to 10 kΩ or 50 Ω, 
depending on your application. Refer to the NI Digital Waveform 
Generator/Analyzer Help for more information about signal termination.

NI 655X

NI CB-2162

Peripheral
Device
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Figure 6.  Dynamic Acquisition Functional Diagram

Step 8. Program the Module Using NI-HSDIO
The NI-HSDIO API includes a set of operations and attributes that use all the 
functionality of the device, including configuration, control, and other 
module-specific functions.

Information about programming with NI-HSDIO is available in the 
NI Digital Waveform Generator/Analyzer Help. This online document 
contains hardware information, concepts, a detailed function/VI reference for 
NI-HSDIO, and information specific to your module.

For the location of example programs you can use as a basis for your first 
NI-HSDIO program, refer to Programming»Getting Started with 
NI-HSDIO in the NI Digital Waveform Generator/Analyzer Help.

Safety and Compliance Information

FCC/Canada Radio Frequency Interference Compliance

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect 
wireless communications from interference. The FCC places digital 
electronics into two classes. These classes are known as Class A (for use in 
industrial-commercial locations only) or Class B (for use in residential 
or commercial locations). All National Instruments (NI) products are 
FCC Class A products.

Depending on where it is operated, this Class A product could be subject 
to restrictions in the FCC rules. (In Canada, the Department of 
Communications (DOC), of Industry Canada, regulates wireless interference 
in much the same way.) Digital electronics emit weak signals during normal 
operation that can affect radio, television, or other wireless products.

NI 655X

NI CB-2162
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RT
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All Class A products display a simple warning statement of one paragraph in 
length regarding interference and undesired operation. The FCC rules have 
restrictions regarding the locations where FCC Class A products can be 
operated.

Consult the FCC Web site at www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not 
installed and used in strict accordance with the instructions in this manual 
and the CE marking Declaration of Conformity1, may cause interference to 
radio and television reception. Classification requirements are the same for 
the Federal Communications Commission (FCC) and the Canadian 
Department of Communications (DOC). 

Changes or modifications not expressly approved by NI could void the user’s 
authority to operate the equipment under the FCC Rules.

Class A

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference when 
the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user 
is required to correct the interference at their own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian 
Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du 
Règlement sur le matériel brouilleur du Canada.

Compliance to EU Directives
Readers in the European Union (EU) must refer to the manufacturer’s 
Declaration of Conformity (DoC) for information2 pertaining to the 

1  The CE marking Declaration of Conformity contains important supplementary information and 
instructions for the user or installer.

2  The CE marking Declaration of Conformity contains important supplementary 
information and instructions for the user or installer.
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CE marking compliance scheme. The manufacturer includes a DoC for most 
hardware products except for those bought from OEMs. In addition, DoCs 
are usually not provided if compliance is not required, for example 
electrically benign apparatus or cables.

To obtain the DoC for this product, click Declarations of Conformity 
Information at ni.com/hardref.nsf/. This Web site lists the DoCs by 
product family. Select the appropriate product family, followed by your 
product, and a link to the DoC appears in Adobe Acrobat format. Click the 
Acrobat icon to download or read the DoC.

Safety Information
The following section contains important safety information that you must 
follow when installing and using the product.

Do not operate the product in a manner not specified in this document. 
Misuse of the product can result in a hazard. You can compromise the safety 
protection built into the product if the product is damaged in any way. If the 
product is damaged, return it to National Instruments for repair.

Do not substitute parts or modify the product except as described in this 
document. Use the product only with the chassis, modules, accessories, and 
cables specified in the installation instructions. You must have all covers and 
filler panels installed during operation of the product.

Do not operate the product in an explosive atmosphere or where there may be 
flammable gases or fumes. If you must operate the product in such an 
environment, it must be in a suitably rated enclosure.

If you need to clean the product, use a soft, nonmetallic brush. Make sure that 
the product is completely dry and free from contaminants before returning it 
to service.

Operate the product only at or below Pollution Degree 2. Pollution is foreign 
matter in a solid, liquid, or gaseous state that can reduce dielectric strength or 
surface resistivity. The following is a description of pollution degrees:

• Pollution Degree 1 means no pollution or only dry, nonconductive 
pollution occurs. The pollution has no influence.

• Pollution Degree 2 means that only nonconductive pollution occurs in 
most cases. Occasionally, however, a temporary conductivity caused by 
condensation must be expected.

• Pollution Degree 3 means that conductive pollution occurs, or dry, 
nonconductive pollution occurs that becomes conductive due to 
condensation.
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You must insulate signal connections for the maximum voltage for which the 
product is rated. Do not exceed the maximum ratings for the product. Do not 
install wiring while the product is live with electrical signals. Do not remove 
or add connector blocks when power is connected to the system. Avoid 
contact between your body and the connector block signal when hot 
swapping modules. Remove power from signal lines before connecting them 
to or disconnecting them from the product.

Operate the product at or below the installation category1 marked on the 
hardware label. Measurement circuits are subjected to working voltages2 and 
transient stresses (overvoltage) from the circuit to which they are connected 
during measurement or test. Installation categories establish standard 
impulse withstand voltage levels that commonly occur in electrical 
distribution systems. The following is a description of installation categories:

• Installation Category I is for measurements performed on circuits not 
directly connected to the electrical distribution system referred to as 
MAINS3 voltage. This category is for measurements of voltages from 
specially protected secondary circuits. Such voltage measurements 
include signal levels, special equipment, limited-energy parts of 
equipment, circuits powered by regulated low-voltage sources, and 
electronics.

• Installation Category II is for measurements performed on circuits 
directly connected to the electrical distribution system. This category 
refers to local-level electrical distribution, such as that provided by a 
standard wall outlet (for example, 115 V for U.S. or 230 V for Europe). 
Examples of Installation Category II are measurements performed on 
household appliances, portable tools, and similar product.

• Installation Category III is for measurements performed in the building 
installation at the distribution level. This category refers to measurements 
on hard-wired equipment such as equipment in fixed installations, 
distribution boards, and circuit breakers. Other examples are wiring, 
including cables, bus-bars, junction boxes, switches, socket-outlets in the 
fixed installation, and stationary motors with permanent connections to 
fixed installations.

• Installation Category IV is for measurements performed at the primary 
electrical supply installation (<1,000 V). Examples include electricity 
meters and measurements on primary overcurrent protection devices and 
on ripple control units.

1  Installation categories, also referred to as measurement categories, are defined in electrical safety 
standard IEC 61010-1.

2  Working voltage is the highest rms value of an AC or DC voltage that can occur across any 
particular insulation.

3  MAINS is defined as a hazardous live electrical supply system that powers equipment. Suitably 
rated measuring circuits may be connected to the MAINS for measuring purposes.



CVI™, LabVIEW™, National Instruments™, NI™, and ni.com™  are trademarks of National Instruments Corporation. Product and 
company names mentioned herein are trademarks or trade names of their respective companies. For patents covering National 
Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file on your CD, or 
ni.com/patents.

© 2003 National Instruments Corp. All rights reserved.


	NI Digital Waveform Generator/Analyzer Getting Started Guide
	Contents
	Conventions
	Step 1. Unpack the Hardware
	Step 2. Verify the Components
	Optional Equipment and Software
	Documentation

	Step 3. Install the Software
	Choose and Install Your ADE
	Install NI-HSDIO
	NI Script Editor

	(Optional) Install the NI Digital Waveform Editor

	Step 4. Install the Module
	Procedure 1: Installing the Module in a PXI Chassis
	Figure 1. PXI Installation

	Procedure 2: Installing the Module in a CompactPCI Chassis
	Table 1. J2 Pins Used by the NI 655X


	Step 5. Configure the Module
	Figure 2. Configuration Tree Shortcut Menu

	Step 6. Use the Test Panel to Generate and Acquire Data
	Step 7. Connect Signals to the Front Panel
	Figure 3. NI 655X Front Panel Connectors
	Table 1. NI 655X SMB Connector
	Table 2. NI 655X DDC Connector Pins
	Connecting Cables and Accessories
	Figure 4. Connecting the NI CB-2162 Accessory

	Wiring for Common Measurements
	Dynamic Generation
	Figure 5. Dynamic Generation Functional Diagram
	Dynamic Acquisition
	Figure 6. Dynamic Acquisition Functional Diagram


	Step 8. Program the Module Using NI-HSDIO
	Safety and Compliance Information
	FCC/Canada Radio Frequency Interference Compliance
	Determining FCC Class
	FCC/DOC Warnings
	Class A

	Safety Information


